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Regulatory Notices

FCC

NOTE: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with this instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

Canada

This Class A digital apparatus complies with Canadian ICES-003.

EU/EMC

This unit complies with the EMC requirement of EN55103-1 and EN55103-2 when operated
in an E2 environment in accordance with this manual.

Important Safety Instructions

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.

AL N T A

WARNING: To reduce the risk of fire or electric shock, do not expose this apparatus to
rain or moisture.

N

Clean only with dry cloth.

8. Do not install near any heat sources such as radiators, heat registers, stoves, or other
apparatus (including amplifiers) that produce heat.

9. No naked flame sources, such as lighted candles, should be placed on the apparatus

10. Protect the power cord from being walked on or pinched particularly at plugs,
convenience receptacles, and the point where they exit from the apparatus.

11. Only use attachments/accessories specified by the manufacturer.

12. Unplug this apparatus during lightning storms or when unused for long periods of
time.

13. Refer all servicing to qualified service personnel. Servicing is required when the
apparatus has been damaged in any way, such as power-supply cord or plug is
damaged, liquid has been spilled or objects have fallen into the apparatus, the
apparatus has been exposed to rain or moisture, does not operate normally, or has
been dropped.

14. Do not expose the apparatus to dripping or splashing and no objects filled with
liquids, such as vases, shall be placed on the apparatus.
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Regulatory Notices

Fuses

WEEE

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

CAUTION: Troubleshooting must be performed by a trained technician. To reduce the
risk of electric shock, do not attempt to service this equipment unless you are
qualified to do so.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized
plug has two blades with one wider than the other. A grounding type plug has two
blades and a third grounding prong. The wide blade or the third prong is provided
for your safety. If the provided plug does not fit into your outlet, consult an electrician
for replacement of the obsolete outlet.

This apparatus must be earthed (grounded) by connecting to a correctly wired and
earthed power outlet.

Ensure that your mains supply is in the correct range for the input power requirement
of the unit.

In order to reduce the risk of electrical shock, the power cord must be disconnected
when the power supply assembly is removed.

This equipment is designed to mount in a suitably ventilated 19” rack; ensure that any
ventilation slots in the unit are not blocked or covered.

The mains power disconnect device for this unit is the plug-in mains cord rather than
a power switch. The mains cord must remain readily accessible for disconnecting
mains power.

To avoid exposure to dangerous voltages and to avoid damage to the unit, do not
connect the rear-panel Ethernet port to telephone circuits.

As the colours of the cores in the mains lead may not correspond with the coloured
markings identifying the terminals in your plug, proceed as follows:

¢ The green and yellow core must be connected to the terminal in the plug
identified by the letter E, or by the earth symbol _L, or coloured green, or green
and yellow. )

e  The blue core must be connected to the terminal marked with the letter N or
coloured black.

e The brown core must be connected to the terminal marked with the letter L or
coloured red.

This apparatus must be earthed.

WARNING: Check that the correct fuses have been installed. For continued protection
against risk of fire, replace only with fuses of the same type and rating. For details on fuse
ratings and instructions on fuse replacement, see Checking the Two User-Serviceable Fuses
on page 10.

PRODUCT END-OF-LIFE INFORMATION

This product was designed and built by Dolby Laboratories to provide many years of
service, and is backed by our commitment to provide high-quality support. When it
eventually reaches the end of its serviceable life, it should be disposed of in accordance
with local or national legislation.

For current information please visit our website at: http://www.dolby.com/environment.
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Regulatory Notices

IMPORTANT SAFETY NOTICE

This unit complies with safety standard EN60065 as appropriate. The unit shall not be exposed to dripping or splashing and no objects filled with liquids, such as
coffee cups, shall be placed on the equipment. To ensure safe operation and to guard against potential shock hazard or risk of fire, the following must be
observed:
o Ensure that your mains supply is in the correct range for the input power requirement of the unit.
o Ensure fuses fitted are the correct rating and type as marked on the unit.
o The unit must be earthed by connecting to a correctly wired and earthed power outlet.
o The power cord supplied with this unit must be wired as follows:
Live—Brown Neutral —Blue Earth—Green/Yellow

IMPORTANT - NOTE DE SECURITE

Ce materiel est conforme a la norme EN60065. Ne pas exposer cet appareil aux éclaboussures ou aux gouttes de liquide. Ne pas poser d'objets remplis de liquide, tels que des
tasses de café, sur I'appareil. Pour vous assurer d'un fonctionnement sans danger et de prévenir tout choc électrique ou tout risque d'incendie, veillez & observer
les recommandations suivantes.
o Leselecteur de tension doit étre placé sur la valeur correspondante a votre alimentation réseau.
o Les fusibles doivent correspondre a la valeur indiquée sur le materiel.
o Lemateriel doit étre correctement relié a la terre.
o Lecordon secteur livré avec le materiel doit étre cablé de la maniere suivante:

Phase—Brun Neutre—Bleu Terre— Vert/Jaune

WICHTIGER SICHERHEITSHINWEIs

Dieses Gerit entspricht der Sicherheitsnorm EN60065. Das Gerit darf nicht mit Fliissigkeiten (Spritzwasser usw.) in Berithrung kommen; stellen Sie keine Geféfle, z.B.
Kaffeetassen, auf das Gerit. Fiir das sichere Funktionieren des Gerates und zur Unfallverhiitung (elektrischer Schlag, Feuer) sind die folgenden Regeln unbedingt

einzuhalten:
o Der Spannungswiéhler muf$ auf Ihre Netzspannung eingestellt sein. @
o  Die Sicherungen miissen in Typ und Stromwert mit den Angaben auf dem Gerit tibereinstimmen.
o Die Erdung des Gerétes muf iiber eine geerdete Steckdose gewahrleistet sein.
o Das mitgelieferte Netzkabel mufl wie folgt verdrahtet werden:
Phase—braun Nulleiter—blau ~ Erde—griin/gelb

NORME DI SICUREZZA - IMPORTANTE

Questa apparecchiatura ¢ stata costruita in accordo alle norme di sicurezza EN60065. Il prodotto non deve essere sottoposto a schizzi, spruzzi e gocciolamenti, e nessun tipo di
oggetto riempito con liquidi, come ad esempio tazze di caffe, deve essere appoggiato sul dispositivo. Per una perfetta sicurezza ed al fine di evitare eventuali rischi di scossa
élettrica o d'incendio vanno osservate le seguenti misure di sicurezza:
o Assicurarsi che il selettore di cambio tensione sia posizionato sul valore corretto.
o Assicurarsi che la portata ed il tipo di fusibili siano quelli prescritti dalla casa costruttrice. @
o  L'apparecchiatura deve avere un collegamento di messa a terra ben eseguito; anche la connessione rete deve

avere un collegamento a terra.
o Il cavo di alimentazione a corredo dell'apparecchiatura deve essere collegato come segue:

Filo tensione—Marrone Neutro—Blu Massa—Verde/Giallo

AVISO IMPORTANTE DE SEGURIDAD

Esta unidad cumple con la norma de seguridad EN60065. La unidad no debe ser expuesta a goteos o salpicaduras y no deben colocarse sobre el equipo recipientes con liquidos,
como tazas de cafe. Para asegurarse un funcionamiento seguro y prevenir cualquier posible peligro de descarga o riesgo de incendio, se han de observar las

siguientes precauciones:
o Asegtirese que el selector de tension esté ajustado a la tension correcta para su alimentacion. ®
o Asegtirese que los fusibles colocados son del tipo y valor correctos, tal como se marca en la unidad.
o Launidad debe ser puesta a tierra, conectandola a un conector de red correctamente cableado y puesto a tierra.
o El cable de red suministrado con esta unidad, debe ser cableado como sigue:
Vivo—Marrén Neutro— Azul Tierra— Verde/Amarillo

VIKTIGA SAKERHETSATGARDER!

Denna enhet uppfyller sikerhetsstandard EN60065. Enheten far ej utsattas for yttre averkan samt féremal innehallande vitska, sasom kaffemuggar, far ej placeras pa
utrustningen. For att garantera sdkerheten och gardera mot eventuell elchock eller brandrisk, maste foljande observeras:

o Konrollera att sakringarna ar av rétt typ och for rétt stromstyrka sa som anvisningarna pa enheten foreskriver.
o  Enheten maste vara jordad genom anslutning till ett korrekt kopplat och jordat el-uttag.
o  El-sladden som medféljer denna enhet maste kopplas enligt foljande:

Fas—Brun Neutral —Bla Jord —Gron/Gul

o  Kontrollera att spanningsvaljaren ar installd pa korrekt natspanning. @

BELANGRIJK VEILIGHEIDS-VOORSCHRIFT:
Deze unit voldoet aan de EN60065 veiligheids-standaards. Dit apparaat mag niet worden blootgesteld aan vocht. Vanwege het risico dat er druppels in het apparaat vallen, dient
u er geen vloeistoffen in bekers op te plaatsen. Voor een veilig gebruik en om het gevaar van electrische schokken en het risico van brand te vermijden, dienen de
volgende regels in acht te worden genomen:
o  Controleer of de spanningscaroussel op het juiste Voltage staat. @
o Gebruik alleen zekeringen van de aangegeven typen en waarden.
o Aansluiting van de unit alleen aan een geaarde wandcontactdoos.
o De netkabel die met de unit wordt geleverd, moet als volgt worden aangesloten:

Fase—Bruin ~ Nul—Blauw  Aarde—Groen/Geel
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Chapter |

Introduction

The Dolby® DMAS8Plus Digital Media Adapter is a direct result of Dolby Laboratories’
continued leadership in the development of innovative cinema technologies. The
DMASPIlus provides all the interface capabilities and digital inputs you're likely to need.
With the DMAS8Plus, you can adapt your existing sound system for digital cinema and
other digital audio sources. The unit provides a straightforward interface to existing Dolby
cinema equipment, such as the CP650, CP500, CP65, CP55, CP45, CP200, and DA20. In
addition, the DMAS8Plus provides theatres with audio solutions to today’s alternative
programming challenges, such as pay-per-view events and digital broadcasting.

The DMAS8PIlus has four separate digital inputs and accepts up to eight channels of PCM
digital audio as well as Dolby Digital and Dolby E bitstreams. Two-channel audio sources
can be decoded as discrete, Dolby Pro Logic®, or Dolby Pro Logic II signals. Analog audio
outputs are calibrated to cinema processor reference levels to ensure a straightforward
interface with your cinema’s existing sound processor.

With the DMAS8Plus, you can present high-quality audio from the following audio sources
and formats:

* Dolby Digital Cinema

* Onscreen advertising servers

e Digital VIRs

¢ Digital satellite or cable TV receivers

e DVDs

s PCM

* Dolby Digital consumer bitstreams
e Dolby E

A separate adjustable global audio delay is assigned to each digital input to ensure that
sound and picture are perfectly synchronized during digital cinema presentations.
Different delays can be assigned to different inputs, providing flexibility for alternative
content sources, which often require different delays.

The DMASPlus is also compatible with existing theatre automation systems and ASCII
command strings. Its ability to handle multiple formats and future upgrades make it an
essential tool for an evolving digital cinema market.

The DMASPIus is designed to fit between an existing DA20 (Dolby Digital film decoder)
and a cinema processor. This allows both the DA20 and DM A8Plus to share the six-channel
input of the cinema processor. When the DMAS8Plus is in Film mode, standard six-channel
analog signals from any source, such as a Dolby DA20, are routed through the DMA8Plus
to the six-channel input of a cinema sound processor (pass-through). In one of the four
digital modes, the DM AS8Plus decodes and routes signals from a variety of nonfilm sources
to the existing cinema sound processor.

Dolby® DMAB8Plus Digital Media Adapter Installation and User’s Manual |



Introduction

1.1 DMAS8PIlus Front Panel

The DMAS8Plus front panel includes the following components:

* Five push buttons to select the input source (digital 1, digital 2, digital 3, digital 4, or
film)

e Four LEDs that indicate a valid clock presence for each digital input

¢ Four LEDs that indicate the current format (PCM, Dolby Digital, Dolby E, or
Aux [auxiliary])

e Three LEDs that indicate the decode mode (Pro Logic II, Pro Logic, or Discrete)

¢ Eight LEDs that monitor the eight-channel analog audio output activity (L, C, R, Sw,
Ls, Rs, 7 and 8)

*  One USB port for firmware upgrades and setup software

dighal 1 dighal2  dighal 3 dighai4  fim rM DobyDgua DobyE  Aux DDooLey Digital Media Adapter

Protogicll  Prologic  Discrete
P . “ i S 3 o

vallg ———————— “——— decode mode ———

Figure 1-1 DMAS8PIus Front Panel

111 Digital Input Push Buttons

When you press any of the digital 1, digital 2, digital 3, or digital 4 push buttons, that button
illuminates, indicating that the selected input is active until you press one of the other push
buttons. Pressing a push button selects a specific digital input source, as shown in

Table 1-1. The DMAS8Plus sends a format pulse to the cinema processor to switch the
processor into the appropriate six-channel input format (see Table 4-7).

% Note: Be sure to use a control cable to connect the cinema processor to the DMAS8Plus
TO CP CONTROL connector.

When in a digital mode, the DMAS8Plus can switch between PCM, Dolby Digital, or Dolby
E encoded bitstreams.

Table 1-1  Digital Push Button Functionality

DI (P Input Source Selected
Button

digital 1 Selects the digital input source from the 4xAES digital input 1 (four-channel
pairs, 25-pin D-connector)

digital 2 Selects the digital input source from the 1xAES digital input 2 (BNC)

digital 3 Selects the digital input source from the 1xAES digital input 3 (BNC)

digital 4 Selects the digital input source from the 1xAES digital input 4 (S/PDIF
optical)
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1.1.2

1.13

114

1.15

1.16

1.1.7

Film Push Button

When you press this button it illuminates, indicating that film mode is active. When the
DMASPIus is in Film mode, audio is received from the analog audio input, which then
passes through to the analog audio output (while the unit is in Film mode or when
powered off). The DMAS8Plus sends a format pulse to the cinema processor to enable an
appropriate format (see Table 4-8). When you press any cinema processor format button,
the DM AS8Plus switches to Film mode without sending its Film mode pulse assertion.

Note: Be sure to use a control cable to connect the cinema processor to the DMAS8Plus
TO CP CONTROL connector.

Valid Input Clock

Each of the four digital input push buttons has a green valid LED located beneath it. These
LEDs illuminate when a valid input clock signal is detected on the respective input
(regardless of whether the corresponding button is selected).

Output Activity LEDs

There are eight signal-level LEDs, one for each channel. The signals are monitored after the
D/A converter output, and before the output relays. The LEDs vary in intensity and are
brightest at +20 dBr (r = 300 mV), while turning off at approximately —26 dBr.

Format LEDs

There are four bitstream format LEDs (PCM, Dolby Digital, Dolby E, and Aux). The Aux
format is currently reserved for future use. These LEDs illuminate when the DMAS8Plus is
actually receiving the respective data format.

Decode Mode LEDs

There are three bitstream processing LEDs, indicating the decode mode (Pro Logic II, Pro
Logic, and Discrete).

USB Port

The USB port is provided for connecting to a PC. You can use it to set up or update the
DMASPlus firmware.
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1.2 DMAB8PIlus Rear Panel

The DMAS8PIlus rear panel includes the following components:
¢ ACinput
® TO CP CONTROL (25-pin male D-connector for cinema processor format interface)
* TO DA CONTROL (25-pin female D-connector for DA20 processor interface)
¢ One 4xAES (AES/EBU) digital input (25-pin female D-connector)
* Two IXAES (AES3) digital inputs (BNC)
* One OPTICAL (S5/PDIF) digital input (Toslink™ connector)

* DIGITAL MEDIA AUTOMATION (9-pin female D-connector from cinema automation
control)

* RS-232 port (9-pin female D-connector for control via ASCII command strings)

* 10BASE-T (RJ45 Ethernet port for control through ASCII command strings, Dolby
Digital cinema systems, and setup/updates)

* AUDIO OUT TO CP (25-pin male D-connector balanced audio to cinema processor)
* ANALOG AUDIO IN (25-pin female D-connector audio from DA20)

; r i @)
O DOBoLEY]  DMABPIus :g C€
0 0 Digital Media Adapter 2y |
TO CP CONTROL XAES XAES.
D SstEal OPTICAL
: © O T
e p Q Q J O

TO DA CONTROL DIGITAL 1IN ANALOG AUDIO IN

O — DIGITAL2IN__ DIGITAL3IN _DIGITAL4 IN 10BASE-T [

Figure 1-2 DMAS8PIus Rear Panel

1.2.1 To CP Control Connector

This connector is a 25-pin male D-connector for connecting to a Dolby cinema processor’s
automation input. It has a floating ground. This output performs the following functions:

e Prevents a DA20 from reverting the cinema processor to a Dolby SR format while the
DMAG8Plus is in a digital mode utilizing the cinema processor in Format 10

* Enables the DMAS8Plus to send a film or digital format command to the cinema
processor to switch the processor to an associated format

¢ Enables the DMAS8Plus to receive and activate a film command from a cinema
processor when the processor’s format button is activated

% Note: A cable kit is available (US customers only) for connecting the DMAS8Plus to a
CP650 or CP500 along with your existing automation connection. If you require this
kit, order CDMA/D.

1.2.2 To DA Control Connector

This is a 25-pin female D-connector for interfacing to a Dolby DA20 CP Sense Control port.
It has a floating ground. This interface prevents or blocks a Dolby SR format reversion from
a DA20 while the DMASPIus is in a digital mode, utilizing a Dolby cinema processor in
Format 10.

4 Dolby® DMA8Plus Digital Media Adapter Installation and User’s Manual



DMAB8PIus Rear Panel

1.2.3  4xAES Input (AES/EBU)

This 25-pin female D-connector receives four AES3 streams, which are linked to the digital
1 button. Typically, this input connects to a Dolby Digital cinema server. It accommodates
PCM audio at 96, 48, and 44.1 kHz (16, 20, and 24 bit), Dolby Digital at all data rates and

sample rates, and Dolby E at frame rates of 23.98 (24 pulldown), 24, 25, 29.97, and 30 fps.

The decoding of coded audio is restricted to the first AES3 channel pair. The clocks for all
four pairs are derived from pair 1. This connector has a floating ground.

1.2.4  1xAES Inputs (AES3)

These BNC connectors are linked to the digital 2 and digital 3 buttons respectively. They
accommodate PCM audio at 96, 48, and 44.1 kHz (16-, 20-, and 24-bit), Dolby Digital at all
data rates and sample rates, and Dolby E at frame rates of 23.98 (24 pulldown), 24, 25,29.97,

and 30 fps. A BNC male to RCA female adapter can interface with most consumer gear.
These connectors have floating grounds.

1.2.5 S/PDIF Optical Input

This Toslink optical connector is linked to the digital 4 button. It accommodates PCM audio
at 96, 48, and 44.1 kHz (16-, 20-, and 24-bit), Dolby Digital at all data rates and sample rates,
and Dolby E at frame rates of 23.98 (24 pulldown), 24, 25, 29.97, and 30 fps.

1.2.6 Digital Media Automation Connector

This interface connects to a theatre automation system. It is a 9-pin female D-connector
providing ground-switching control of the front-panel input selection buttons. It has a
floating ground. The automation system can switch between film sound (pass-through)
and any of the four digital media sources. This function duplicates the front-panel digital
input buttons and the film button. Two pins (6, 7) provide relay dry contact closure
whenever you select either digital 1, digital 2, digital 3, or digital 4 (the relay contacts open
when Film mode is selected) for CP200 digital subwoofer logic control.

1.2.7 RS-232 Serial Port

You can use this port for serial control using ASCII string commands. Set this port to 9600

and 8 1 and use a pin-to-pin serial cable. You can also perform the same function using
the Ethernet port, as described in Section 1.2.8.

1.2.8 Ethernet Port

This is an illuminated RJ45 10BASE-T Ethernet port with activity LEDs, which provides an
interface to a Dolby Digital Cinema network and also serial control through telnet protocol
to port 61412. You can also use this port for setup software and firmware upgrades.
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1.2.9 Audio Out to CP Connector

This connector is an eight-channel analog output (L, C, R, Ls, Rs, SW, and unassigned
channels 7 and 8), which is present on a male 25 pin D-connector (300 mV reference level).
This is either the audio received from the ANALOG AUDIO IN port (Film mode) or the audio
converted from one of the digital input sources. This connector has a floating ground.

Caution: When connecting the DMAS8Plus to a CP45, CP55, CP65, or CP200, be sure to
ground the negative side of all audio channels. Failure to do so will result in a
reduced audio output level (approximately —6 dB) for that channel. The original
audio cables for these processors (DA20 to CP audio cables) were designed for
unbalanced audio. As a result, not all grounds are connected to the negative side
of the associated channel. You can insert the Cat. No. 757 audio cable adapter
dongle with the existing audio output cable to ensure proper grounding of all
CP45, CP55, CP65, or CP200 channels. For more information, see DMA8Plus
Audio Out to CP Pinouts on page 44.

1.2.10  Analog Audio In Connector

This is an eight-channel analog input (L, C, R, Ls, Rs, SW, and unassigned channels 7 and
8) designed to receive 300 mV (ref) inputs from a DA20 or other external sources and inputs
on a female 25-pin D-connector. This analog input signal passes through the DMA8Plus
(when in film mode) via relay contacts. These relay contacts are normal to “pass-through”
when the DMAS8Plus is not powered on. This connector’s ground passes through the
AUDIO OUT TO CP connector in film mode, and is otherwise floating.
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Chapter 2

Installation and Maintenance

2.1 DMAS8PIlus Floating Signal Grounds

The DMAS8Plus is designed to eliminate ground loops, which can occur when the unit is
connected to multiple external equipment grounds. For this reason, the following
DMAS8PIlus connectors have isolated grounds:

* Analog audio inputs and outputs: When in Pass-Through (film) mode, the low side of
each signal is switched along with the hot side. Note that the positive side of the
signal is capacitively coupled. If the external signal passing through is balanced, the
output is also balanced. When in internal (digital) modes, the output is floating and
balanced. Any common mode signal between the DMAS8Plus audio outputs and its
chassis ground must not exceed + 6V peak.

* DIGITAL MEDIA AUTOMATION connector: the common is floating and can be + 10V
peak from the chassis ground.

®* TOCP CONTROL and TO DA CONTROL connectors: The common is floating and can be
+ 10V peak from the chassis ground. Note that the CP/DA common is separate from
the DIGITAL MEDIA AUTOMATION common.

e 1xAES BNC digital inputs: These are transformer isolated and their grounds can be
+10V peak from the chassis ground.

® 4xAES D-connector digital inputs: These are transformer isolated and their grounds
can be + 10V peak from the chassis ground.

Note: The RS-232 input ground is connected to the DMA8Plus chassis ground and is not
floating.

2.2 Digital Audio Inputs

There are two professional interface methods used for digital audio: AES/EBU (also known
as AES3) and AES-3id. These methods stream the same digital data and professional audio
header information over copper conductor links, but use different types of conductors and
connectors.

AES/EBU uses a balanced connection (two conductors plus shield) with a characteristic
input impedance of 1100, nominal peak-to-peak signal level of 5 V, and, most commonly,
XLR connectors. The typical maximum transmission distance is 100 meters (328 feet).
AES-3id uses an unbalanced connection (one signal conductor plus shield) with a
characteristic input impedance of 750, peak-to-peak signal level of 1 V, and BNC (“push
and twist”) connectors. The typical maximum transmission distance is 1,000 meters (3,280
feet).
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Professional digital audio equipment typically uses the AES/EBU method because
balanced operation yields superior noise immunity, as it does with analog audio signals,
and because XLR connectors are the standard on analog professional audio equipment.

Professional video equipment typically uses the AES-3id variation of this interface, with
BNC connectors. As with XLR connectors on professional audio equipment, the adoption
of BNC connectors for the audio on professional video equipment stems from the existing
use for the video signal. Also, the unbalanced AES-3id signal can connect to more than one
piece of equipment by using the loop-through connectors available on some devices. The
signal is robust for long cable runs.

2.2.1 Consumer Interface Standards for Digital Audio

The consumer interface standard for digital audio is S/PDIF (IEC 61937). S/PDIF uses
coaxial unbalanced connections (one signal conductor plus shield) with a characteristic
input impedance of 75Q with RCA (phono) connectors, or a fiber-optic cable with Toslink™
connectors. The unbalanced coaxial connection has a peak-to-peak signal level of 0.5 V. The
typical maximum transmission distance is 10 meters (33 feet). Although S/PDIF-specific
cables with suitable connectors can be purchased, you can also obtain good results using
high-quality 75Q video cable with the appropriate connectors and/or adapters.

2.2.2 Cable Issues

Even in digital audio, noise-free signals are very important. The cable used for digital
signals is specifically designed for such use, although it looks the same as the cable used
for analog audio or video signals. Any professional audio equipment or broadcast supply
company can provide 110Q cable with connectors (or without, if you'd like to terminate
them yourself) for AES/EBU connections, and high-quality 75Q video cables with BNC
connectors for AES-3id connections. Use of cables or connectors not designed for digital
transmission or with incorrect impedance compromises the integrity of the bitstream. This
can result in unreliable hardware interconnections, especially with long cable runs.

2.2.3 Multiple Sources: Conversion Between Interface Standards

Although some details of the bitstreams used in the AES and S/PDIF standards are
different, the audio information is exactly the same. As a result, most audio equipment
accepts either standard with no need to convert the bitstream itself; this is the case with the
DMASPlus. However, if you intend to connect sources across different types of digital
audio inputs, do not attempt to convert a digital interface type by directly wiring an XLR
connector to a BNC or RCA plug. This causes an impedance mismatch and signal
reflections, resulting in digital waveform degradation. This may appear to work, but the
results are unreliable and dropouts occur.

For conversion between the AES-3id and S/PDIF formats, you can use high-quality
RCA-to-BNC adapters because the cable and impedance are both the same (75Q).

For conversion between the AES/EBU and AES-3id or AES/EBU and S/PDIF formats, a
simple and economical method uses inline transformers. These devices perform the
necessary impedance and balanced/unbalanced conversion. Table 2-1 shows some
examples of suitable adapters. The unbalanced connector in these examples is BNC.
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You can add BNC-to-RCA adapters for connecting to consumer S/PDIF connections. The
following units use passive circuitry.

Table 2-1  Examples of Available Balanced/Unbalanced Adapters

Adapter Type Neutrik® Canare®
XLR female 110Q in INA-BF BCJ-XJ-TRA
to BNC female 75Q out
BNC female 75Q in NA-BM BCJ-XP-TRA
to male XLR 110Q out

Higher-priced units incorporating active circuitry are also available. These offer additional
features like multiple inputs, inputs for Toslink digital connections, and multiple outputs.

2.3 Connections

For connecting the DMAS8Plus to your cinema processor, refer to Wiring Diagrams on
page 11. Use the appropriate diagram for your cinema processor model.

For proper operation in locations where there is considerable RF or other interference field,
strictly adhere to the cable types, lengths, and pin assignments. Shields must connect only

to the chassis and should not be paralleled with the negative side of inputs or outputs.

Pinout information for each connector is listed in Rear-Panel Connector Descriptions and
Types on page 36.

2.4 Fuse Information

a Warning: To reduce the risk of fire, replace fuses only with the same type and rating.

The DMAS8Plus uses a universal-switching power supply that handles the full range of
nominal mains voltages between 100 and 240 VAC, and any frequency between

50 and 60 Hz. If a power supply fuse blows, do not attempt to replace it. In such a case,
please contact Dolby Laboratories for a replacement power supply.

There are two fuses on the Cat. No. 758 board, which are user serviceable, as described in
Checking the Two User-Serviceable Fuses on page 10.
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24.1 Checking the Two User-Serviceable Fuses
The fuse rating for the user-serviceable fuses is:

T 1A L (time-lag, 3.15 amp, 250 V, 20 mm, slow blowing) for all operating voltages.

a Warning: Before performing the following steps, be sure to disconnect the DMA8Plus
power cable from the power source.

Open the DMAS8Plus lid.
Remove the fuse cover, which covers the fuses.

Remove the two fuses from their slots, check each of them, and replace, if required.

Ll

Replace the fuse cover.

Figure 2-1  Checking the User-Serviceable Fuses
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2.5 Mains Power Wiring

In some countries the primary mains cable may not have a connector fitted. These
nonterminated leads must be properly wired to an approved mains connector in
accordance with the following international code:

* Brown wire: Live or hot

* Blue wire: Neutral

* Green wire: Mains ground

a Warning: If you are uncertain about the wiring of your AC mains outlet then do not use
it. Consult a qualified electrician.

2.6 Wiring Diagrams

This section contains connection diagrams for these cinema processors.
e (CP650

e (CP500

e CP65/DA20

e (CP55/DA20

e (CP45/DA20

e (CP200/DA20

Choose the appropriate diagram based on your installed equipment.
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Belden 8451 two-conductor shielded cable or
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standards. For D-connectors, a metal housing
must be used and the shields must be connected
to the housing.
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and 83528).

6. Caution: Be sure to ground the negative side of
all audio channels. The original CP audio cables
were designed for unbalanced audio. Not all
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immunity required by the FCC and European EMC
standards. For D-connectors, a metal housing
must be used and the shields must be connected
to the housing.

5. Re-attach existing cables (Dolby Part Numbers
83132 and 83133) to the DMA8PIus as shown.
(Cables are included in CDA/55 cable set.) The
Shielded Audio and Data Cables are included in
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and 83528).

6. Caution: Be sure to ground the negative side of
all audio channels. The original CP audio cables
were designed for unbalanced audio. Not all
grounds are connected to the negative side of the
associated DMA8PIus channel. Insert the Cat. No.
757 audio adapter as shown on the diagram.
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1. Follow all local electrical and building codes.

2. Use earthed (grounded) conduit wherever
possible. Avoid routing signal wiring near electric
motors, rectifiers, power wiring, dimmer wiring, or
other sources of electrical noise.

3. For two-conductor with shield wiring, use Belden
8451 two-conductor shielded cable or equivalent:
tinned copper, twisted pair, 22 AWG stranded tinned
copper drain wire, aluminum-polyester shield, 100
percent shield coverage, conductor to conductor
(111 pF per meter).

4. All shields must be connected to the chassis of
the DA20 or DMAB8PIus rather than to circuit (audio)
ground. This achieves the RF interference immunity
required by the FCC and European EMC standards.
For D-connectors, a metal housing must be used
and the shields must be connected to the housing.

5. Re-attach existing cables (Dolby Part Numbers
83306 and 83135) to the DMA8PIlus as shown.
(Cables and Cat. No. 545A are included in CDA/45
upgrade kit. All existing Cat. No. 545 assemblies
must be upgraded to Cat. No. 545A. The Shielded
Audio and Data Cables are included in CDMA/A
cable set (Dolby Part Numbers 83442 and 83528).

6. Caution: Be sure to ground the negative side of
all audio channels. The original CP audio cables
were designed for unbalanced audio. Not all
grounds are connected to the negative side of the
associated DMA8PIus channel. Insert the Cat. No.
757 audio adapter as shown on the diagram.
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Wiring Diagrams
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1. Follow all local electrical and building codes.

2. Use earthed (grounded) conduit wherever
possible. Avoid routing signal wiring near electric
motors, rectifiers, power wiring, dimmer wiring, or
other sources of electrical noise.

3. For two-conductor with shield wiring, use Belden
8451 two-conductor shielded cable or equivalent:
tinned copper, twisted pair, 22 AWG stranded tinned
copper drain wire, aluminum-polyester shield, 100
percent shield coverage, conductor to conductor
(111 pF per meter).

4. All shields must be connected to the chassis of
the DA20 or DMAB8PIus rather than to circuit (audio)
ground. This achieves the RF interference immunity
required by the FCC and European EMC standards.
For D-connectors, a metal housing must be used
and the shields must be connected to the housing.

5. Re-attach existing cables (Dolby Part No’s 83137
and 83138) to the DMA8PIus as shown. (Cables
included in CDA/200 cable set.) The Shielded Audio
Cable is included in the CDMA/A cable set.
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Chapter 3

Setting up the DMAS8PIlus

3.1 DMAS8PIus Setup Software

The setup software is required to complete the DMAS8Plus installation and perform other
functions. You begin by installing the setup software on a PC running Microsoft®
Windows® XP Service Pack 2 or later. When the installation is completed, you launch the
setup software, and then connect your PC to the DMAS8Plus using a USB cable (as
described in Installing and Running the Setup Software on page 20) to perform the
following functions:

Select the model number of the cinema processor connected to the DMAS8Plus for
DA/CP control

Enter the network settings
Select the PCM input-channel routing
Set the Global delay for each digital input

Set the 2Ch Decode Mode (Auto, Pro Logic®, Pro Logic Il, or Discrete L/R) for PCM,
Dolby® Digital, and Dolby E

Enable or disable Silent Switch mode

Enable or disable Dialog Normalization for Dolby Digital bitstreams
Set the Surround Delay

Select the Pro Logic subwoofer filter

Select the Power-on Mode

Select the ‘To CP Control’ Pin Assignments

In addition, the setup software displays the following information:

Sample Rate and Data Rate (when available)

Dialnorm and Channel Mode metadata information (when available)
Signal-level monitoring level meters

Current input selection

Audio format (PCM, Dolby Digital, Dolby E, or Aux)

Decode mode (Pro Logic, Pro Logic Il, or Discrete)

Version numbers for the DMAS8Plus firmware and setup software
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3.2 Installing and Running the Setup Software

1. Run the DMAS8PIlus installation program to install the setup software on your PC.
The welcome screen appears, as shown in Figure 3-1.

Dolby DMASPIus - InstallShield Wizard [gl

Welcome to the Inzstall5hield Wizard for Dolby
DMABPIus

The InstallShield *izard will install Dolby DMASPUE on
wour computer. To continue, click Mest.

[ Nest> |[ Cancel

Figure 3-1  Installation Welcome Screen

2. Click Next, then follow the onscreen instructions to install the software.

3. Launch the setup software by selecting Start>Programs>Dolby>DMA8PIus Setup, then
connect your PC to the DMAS8Plus front-panel USB port to establish a connection.

The DMAS8PIlus Profile settings window appears, as shown in Figure 3-2.

3.3 Profile

When you launch and connect the DMAS8Plus setup software, the Profile settings window

appears, as shown in Figure 3-2. The virtual status monitor appears in the lower section of
the window.

Near the top of the window, there are also tabs for Network, Digital Input 1, Digital Input 2,
Digital Input 3, Digital Input 4, and Global Settings. When you click any of these tabs, the
corresponding parameter window appears where you can enter and/or modify the
respective settings, as described in the sections that follow. The virtual status monitor also
appears at the bottom of each of these tab settings windows. Following is a description of
the Profile settings and the virtual status monitor.
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Profile

00 DMABPIus : USB
File Action ‘Window Help

[0 | Profile | Network | Digital Input 1 | Digital Input 2 | Digital Input 3 || Digital Input 4 | Global Settings|

Theater Profile rInput Description

=
E | omasplus serial Number | 20 Digital 1 (4xAES) | Dolby Digital Cinema System

Theatre Name | Dalby Cinerna 1 Digital 2 (1xAES) | Pre-Show Advertising Server |
Auditarium Mumber | 1 Digital 3 (1xAES) | Alcernative Content Source |

Digital Cinema System | Dolby DSP100, DS5100 ~System Info

|
|
|
Cinema Processar | cPs00 || (serial number 53500) | Digital 4 {Cptical) | OYD Player
|
|
|

Digital Cinema Projector | yes Host Marne DMAGPlus
Al Sy | Dalby NALD Ethernet Address  00:d0:46:01:41:74

IP Address 192,1658.1.131
Comments The DMABPIs sounds great!

System Software  1.3.2.2
Remote Software  1.2.2.0

Hardware Revision 2

" . DMASPlus
Digital Media Adapter

Pro Logic Il Pro Lagic
-« -«

“—— decode mode ——

= T

Figure 3-2  Profile Settings Window

3.3.1 Profile Settings

Selecting this tab displays the Profile settings window. In this window, you can enter the
corresponding information for your system. This information defines the Theatre Profile for
the local auditorium. In addition, Input Descriptions appears for each digital input. You can
edit each description and enter the desired information.

3.3.2 Virtual Status Monitor

The virtual status monitor provides a user-friendly interface that is similar to the
DMASPIlus front panel. Its eight-channel signal-presence meter monitors the DMAS8Plus
analog output (before the bypass relays). Five virtual buttons represent the digital 1, digital
2, digital 3, digital 4, and film input selections. When you click any of these buttons, the
associated input is activated. Each of the digital input buttons has an associated virtual
LED, representing a valid clock presence. In addition, four virtual LEDs represent format
decoding, one each for PCM, Dolby Digital, Dolby E, and Aux (for future use). Three more
virtual LEDs represent the decode mode, one each for Pro Logic Il, Pro Logic, and Discrete.
Parameter indicators display the Sample Rate, Data Rate, Dialnorm, and Channel Mode
(when available).
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34 Network

Selecting this tab displays the DMAS8Plus Ethernet Settings window, as shown in

Figure 3-3. In this window, you can configure the DMA8Plus network settings. If you
change the network settings, two buttons are highlighted below your settings: Discard
Changes and Apply Changes. Clicking one of these buttons performs the respective action.
The default entries are set for a Dolby Digital Cinema system. Following is list of these
default entries:

* Host Name: DMAS8Plus

* DHCP: Disable

e |IP Address: 192.168.x.131 (x = auditorium number)

® Subnet Mask: 255.255.255.128

e Default Gateway: 192.168.x.129 (x = auditorium number)

D00 DMASPlus : USB

File Action wWindow Help

I3 | Profile | Network | Digital Input 1 | Digital Input 2 | Digital Input 3 | Digital Input 4 | Global Settings

rEthernet Setting:

=
|| Host Name DMARPlUS

() Enable

DHCP
(%) Disable

IP Address .
Subnet Mask. 5 E
Default Gateway , 168 |. .

Discard Changes Apply Changes

o | [ =
&
™
raf e e
w||@ | =

DMABPIUS
DO DoLEY] Digital Media Adapter

= o st

Figure 3-3  Ethernet Settings Window
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Digital Inputs 1, 2, 3, and 4

3.5 Digital Inputs 1, 2, 3, and 4
Selecting any of these tabs displays the corresponding digital input window. The examples
in Figure 3-4 and Figure 3-5 show the Digital Input 1 and Digital Input 2 windows. The same
setting options are provided in each digital input window, except for the PCM Channel
Assignment, which appears only in the Digital Input 1 window. Following is a description
of each of these settings.

DO DMA8PIlus : USB

File Action Window Help
[0 | Profile | Network | Digital Input 1 | Digital Input 2 | Digital Input 3 | Digital Input 4 || Global Settings|
~
z 110/%
Channel Assignment 2Ch Decode Mode 2Ch Decode Mode 2Ch Decode Mode
AES Input Assigned To () Pro Logic (&) Auto Auto
Cht Left v LIR C/5w Ls/Rs () Pro Logic 11 () Pro Logic Pro Logic
CI’L 2 Right v L/C RILs Rs/5w (%) Discrete LIR () Pro Logic 11 Pro Logic IT
ch3 Discrete LR Discrete LR
| [Center ] LlLs CJRs R/Sw o
Ch4 P — Processing Mode Dialog Mormalization Dialog Mormalization
chs Left Surround e Discard changes (%) Minimum Latency () Enable Enable
|
che Right Surround % Apply changes () Silent: Switch (%) Disable Disable
ch7 Left Extra - O Mute
| -
chs Right Extra 4 Program Select
P1 B2 G Y

" . DMASPlus
Digital Media Adapter

—eeeee inputselect —————————————
digital 1 digital 2 digital 3 digital 4

- W E ..

= o p—

format
PCM  DolbyDigital  DolbyE

’ - -

Pro Logic Il Pro Logic
- -

“—— decode mode ——

| Ready

Figure 3-4  Digital Input 1 Window
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3.5.1

3.5.2

00 DMABPlus : USB

File Action ‘Window Help

[ | Profile | Metwork | Digital Input 1| Digital Input 2 | pigital Input 3 | Digital Input 4 || Global Settings|

~u

g PreshowAdvertsingServer e e
=]

PcM. DobyDigtl  Dobye

2Ch Decode Mode 2Ch Decode Mode 2Ch Decode Mode
() Pro Logic () Auto Auto
(%) Pro Logic I () Pro Logic Fro Logic
() Discrete L{R (%) Pro Logic I Fro Logic IT

() Discrete L{R Discrete L{R
Processing Mode Dialog Mormalization Dialog Mormalization
(%) Minimurn Latency (%) Enable Enahle
() Silent: Switch () Disable Disable
O Mute

Program Select
FI (P2 (O)F3 )P4

DMABPIuS
00 DoLBY Digital Media Adapter

Dolby Digital Dalby E
L

Pro Logic Il Pro Logic D
- -

“—— decode mode ——

= oo enss

Figure 3-5  Digital Input 2 Window

Global Delay

Specifies an audio delay (in addition to the DMA8Plus decoding delay of approximately
7 ms for 4xAES PCM). This function synchronizes the audio with the video that is required
for digital cinema projectors, which add a video processing delay. Use the up and down
arrows to set the Global delay between 0 and 250 ms. You can specify a different Global delay
for digital 1, digital 2, digital 3, and digital 4.

Systems that use an external video scaler may add another decoding delay.

PCM Settings

Following is a description of the PCM settings.

PCM Channel Assignment (Digital Input 1 Only)

The analog audio output channels (L, R, C, LFE, Ls, Rs) are always fixed and hardwired to
a cinema processor. However, when a PCM bitstream input-channel mapping is not a
default SMPTE configuration (L/R, C/LFE, Ls/Rs), you must reassign the input channels to
match the hard wired audio outputs. For channel reassignment, the surround delay and
the LFE filter are always tied at the output.
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To reassign the input channels, use the drop-down menu for each of the AES channel
inputs or click one of the three preset buttons (L/R C/Sw/ Ls/Rs, L/C R/Ls, Rs/Sw, or

L/Ls C/Rs R/Sw). To activate your changes, click the Apply changes button. To cancel your
changes, click the Discard changes button.

2Ch Decode Mode

These options apply only to a two-channel input stream. There are three options: Pro Logic,
Pro Logic Il, and Discrete L/R.

Note: For Dolby Digital Cinema multichannel PCM, you must use the Discrete L/R option.

Processing Mode

Minimum Latency

When selected, this default mode provides the quickest audio processing (approximately
7 ms) for PCM audio.

Silent Switch

When selected, this mode constantly checks for transitions between PCM and coded audio,
and switches between the two silently. This mode adds a 40 ms latency to the audio
processing (for a total latency of approximately 47 ms).

Mute

When selected, this mode mutes the audio when PCM is detected.

3.5.3 Dolby Digital Settings

Following is a description of the Dolby Digital settings,

2Ch Decode Mode

For two-channel configurations, there are four options: Auto, Pro Logic, Pro Logic I, and
Discrete L/R. The audio decode mode follows the surrounds metadata parameter that is
embedded within the bitstream. Alternatively, you can enable Pro Logic or Pro Logic II
decoding, which overrides the presence or absence of the surrounds metadata in
two-channel bitstreams. The Discrete L/R mode sends the audio only to the Left and Right
channels.

Dialog Normalization

When enabled (Enable), this option sets the decoder level shift according to the encoded
metadata embedded in a Dolby Digital (AC-3) bitstream. Metadata is available on most
DVDs, terrestrial and satellite broadcast signals, and other Dolby Digital sources. The
default is Disable.
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3.54 Dolby E Settings

Following is a description of the Dolby E settings.

2Ch Decode Mode

Same functionality as for Dolby Digital, as described previously.

Dialog Normalization

Same functionality as for Dolby Digital, as described previously.

Program Select

You can select one of four possible programs to receive a Dolby E bitstream: P1, P2, P3, or

P4. The default is P1.

3.6 Global Settings

Selecting this tab displays the Global Settings window, as shown in Figure 3-6. Following

is a description of each of these settings.

00 DMABPIus : USB

File Action Window Help

[ | Profile | Network | Digital Input 1 || Digital Input 2 | Digital Tnput 3 | Digital Input 4| Gobal SettinQS]

[ | P Setting:

= Cinema Processor | -psgg

'To P Contral' Pin Assignments

Film 7(56) v
Digital Media |5 ;54 v

~Pro Logic § Pro Logic IT Subwoofer——————————————

(3)50Hz

() 100 Hz

~Surround Delay

Distance from screen ko

rear wall of theatre Fest (%) Fest () Meters
Average distance between
left and right surround speakers IFeet Calculate
27 ms
-
i M T T
0 S0 100

rPower-on Mod
() Last Setting

() Film

() Digital 1 (4xAES
O]
() Digital 3 (1:xAES)
() Digital 4 (Optical)

o . DMABPIus
Digital Media Adapter

digital 4 film

Pro Logic
-

Pro Logic Il
-

“—— decode mode ——

| Ready

Figure 3-6

Global Settings Window
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3.6.1 CP Settings

Following is a description of the cinema processor (CP) settings.

Cinema Processor

Selects the cinema processor connected to the DMA8Plus. This parameter affects the ‘To CP
Control’ Pin Assignments. If you are not using a Dolby processor, select Custom and set the
appropriate “To CP Control’ Pin Assignments for your setup.

‘To CP Control’ Pin Assignments

The pin assignments for Film and Digital Media correspond to the cinema processor’s
nonsync format and six-channel input format. For default CP formats on control lines 0—7
(pins 1-8) see Table 4-7. The various DMAS8Plus cinema processor Film defaults correspond
to each cinema processor’s default nonsync format. Likewise, the Digital Media defaults

correspond to each cinema processor’s default six-channel input format. You can change
any of these pins manually to accommodate your setup.

3.6.2 Surround Delay

When the unit receives audio from a digital media source, you need to apply a delay to the
Surround channels, so the Center and Surrounds audio reach the listener at the same time.
Set the Surround Delay by entering the dimensions of the auditorium and clicking the
Calculate button, or use the slider if you know the required delay setting.

Note: If the DMAS8Plus is connected to a CP650, the CP650 applies the appropriate digital

E media surround delay based on its settings (format 11). If the CP650 has been
selected as the cinema processor type, the Surround Delay setting in this window is
disabled. Use this function to set the digital media surround delay only when
connected to other cinema processors.

3.6.3 Pro Logic/Pro Logic Il Subwoofer

Selects a subwoofer filter of 50 Hz (default) or 100 Hz for Pro Logic and Pro Logic II
decoding. This subwoofer signal is derived from the matrix decoded sum of Left, Center,
and Right, which passes through this filter. The main audio outputs bandwidth (L, C, R) is
not affected because this subwoofer signal is a reinforcement rather than a bass redirection.

3.64 Power-on Mode

Selects the desired DMAS8Plus startup mode when the unit is powered on. You can select
Last Setting, Film, or any of the digital inputs: digital 1 (4xAES), digital 2 (1XAES),
digital 3 (1XAES), or digital 4 (Optical).
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3.7 File Menu

You can use the setup software File menu to load and save settings. Following is a
description of each of these functions.

3.7.1 Loading Settings
You can load a previously saved .dlb parameter file as follows:

Select Open in the File menu, browse to the desired .dlb file on your PC, and open that file.

FIEN Ackion  Window

B

= Open... Chl+O

B save  Ch4s
Save As..,

Exxit Alt+F4

Figure 3-7  Selecting Open in the File Menu

3.7.2 Saving Settings
You can save your current settings to a .dlb parameter file as follows:
Select Save in the File menu, browse to the location on your PC where you want to save the

file, enter a file name, and click Save. To modify an existing .dIb file and save it under a
different name, open the file, then select Save As in the File menu.

FI=N Action  Window

= Cpen... Chrl+O
-

Exit Alt+F4

Figure 3-8  Selecting Save in the File Menu
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3.8 Action Menu

You can use the setup software Action menu to connect to a local or remote device and
update the DMAS8Plus firmware, as described in the sections that follow. The Extract Logs

and View Log options currently do not function. To extract an event log, see ASCII String
Commands on page 42.

Extract Lags...

Wiew Log ]

Connect ta local device
Connect ko remate device

Update Software. ..

Figure 3-9  Action Menu

3.8.1 Connecting to a Local or Remote Device

These options allow you to connect to a DMAS8Plus that is connected to your PC (local
device) or a DMAS8Plus that is connected to an Ethernet network (remote device). If you
select Connect to remote device, a prompt for an IP address appears, as shown in
Figure 3-10. Enter the IP address of the remote DMA8Plus and click OK.

% Note: If you are connecting directly to a DMAS8Plus, use a crossover cable. If you are
connecting to a switch, use a standard Ethernet cable.

€ , Connectto DMASPIus ak address:
ot |

[ oK l [ Cancel

Figure 3-10 Connect to Remote DMA8PIlus Prompt

3.8.2 Update Software

With setup software version 1.2.5.0 and later, when you select this option, the setup
software closes and Dolby Software Update automatically opens and connects. You can
then update the DM AS8Plus firmware by following the directions in Updating the
DMAS8Plus Firmware on page 31. When the update is completed, Dolby Software Update
closes and the setup software opens and reconnects.
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3.9 Window Menu

You can use the Window menu to toggle in and out of Expert View mode. In addition, you
can turn the Setup (tabs view) and/or Monitor display(s) on or off.

Expert Wiew

v Setup
v Maonikar

Figure 3-11 Window Menu

Using Expert View

When you select Expert View, all the DMAS8Plus parameters and command strings appear,
including some parameters not displayed in the tabs view. You can modify each of the
parameters that are highlighted in green by double clicking on any of these (or selecting
one and pressing <Enter>), and then typing the new parameter entry. For more
information, see ASCII String Commands on page 42. To return to the tabs display, select
Expert View again to uncheck it.

DO DMABPIus - USB

File Action Window Help
B parameters highlighed in green can be modified by double clicking or pressing enter
Parameker Value
- _ Parameters below are available in both expert and tab views ~

dmasplus.state.bitstream_Format_a PCM

dmagplus.state. channel_mode n_a

dmadplus.state.data_rate_a n_a

dmasplus.state.decode_maode prologic_2

dma8plus.state.dialnorm_a ] L4

dmasplus.state.dig_1_valid 1

dmasplus.state.dig_2_valid 0

dmasplus.state.dig_3_valid 0

dmasplus.state.dig_4_valid 0

dmasplus.state.ip_skatus 192,168.1.131 255,255,255,128 192,.1658,1.129

dmasplus.state.meters 0101010101010101

dmasplus.state.sample_rate_a 48

dmasplus. sys. auditorium_number 1

dmagplus.sys. auta_line_digital 4

dmasplus.sys. auta_line_film 6

dmagplus.sys. automation_kext Dalby MALD

dmasplus.sys.cinema_system_text Dalby DSP100, DS5100

dmagplus.sys.comment_text The DMASPIUs sounds great! 3
= [T e

Figure 3-12 Expert View Window
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3.10 Updating the DMAS8PIus Firmware

To update the DMAS8Plus firmware:

1. Obtain the latest version of the Dolby Software Update application from Dolby
Laboratories and install it on your PC.

2. Obtain the .dlb update file from Dolby Laboratories and copy it to your PC.
3. Connect your PC to the USB port on the DMAS8Plus front panel.
4. Select Start>Programs>Dolby>Dolby Software Update to launch the update application.

m Nolby Software Update E_||E|E|
File Help

Canfigure Device Connection

Skatus: EW‘

Maode! |55

Select Update Filsis)

Update Fi: - nsgplusines stuff\OMASPlusFimware 1 3 2 3.db v | [ Browse
v

Hast: | 2 - | |

Connected Device Information

Update File Information

Device: | oMasPILs

Device: | DMABPIus

Setial Number: |0 Name: | DMABPIus

Bootloader Version: | 1.1.0.8

version:  [1.3.2.3

Last Lpdate Date: |

| |
System Version: [ 1.1.0.8 | Description: | Full Software for the DMAGPIUS |
| |
| |

Issus Date: | Wednesday, April 11, 2007 11:40:23 AM GMT-07:00

reinstall all components []

Figure 3-13 Dolby Software Update Screen

5. Click Browse to find the .dlb update file on your PC, then click Open.
6. Click Update.

After a few seconds, a progress bar displays the status of the update process. When the

process is completed, the DMAS8Plus automatically reboots with the updated
firmware.
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Chapter 4

4.1

Technical Reference

DMAS8PIus Specifications

PC Connection

USB port for setup operations and software upgrades

Input Selector Buttons

Digital 1 through 4 source buttons
Film source button (pass-through)

Indicators
Valid LEDs indicate digital input clock presence for each digital input
Format LEDs indicate PCM, Dolby Digital, Dolby E, or Aux (future) processing

Decode mode LEDs indicate Pro Logic II, Pro Logic, or Discrete modes
Output activity LEDs indicate the presence of signals in each output channel

Construction

1-U rackmount chassis frame

Digital Signal Inputs

All have floating grounds, +10 V peak difference between the DMA8Plus chassis and signal
common permitted

Digital 1 In (4xAES)
25-pin female D-connector provides four AES/EBU inputs of PCM audio (up to eight

channels)
Input impedence: 110 Q

Digital 2 In (1XAES)

Male BNC connector, unbalanced per AES-3ID-1995/SMPTE 276M
Input impedence: 75 Q

Digital 3 In (1XAES)

Male BNC connector, unbalanced per AES-3ID-1995/SMPTE 276M
Input impedence: 75 Q
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Digital 4 In (Optical)

Optical connector for digital input

Digital Audio Source Formats
PCM: 44.1, 48 and 96 kHz; 16-, 20-, 24-bit
Dolby Digital (AC-3)
Dolby E (23.98, 24, 25, 29.97, 30 fps)

Dolby Pro Logic II
Dolby Surround Pro Logic

Dolby Cinema Processor Compatibility

CP650, CP500, CP200, CP65, CP55, CP45, DA20

Global Delay

Adjustable delay of all channels from 0-250 ms (separate delay for each input)

Surround Channel Delay

Digital media program sources: adjustable from 0-150 ms

Power Requirements

100-240 VAC, 50-60 Hz

Analog Audio Input

25-pin female D-connector for six-channel analog output of a Dolby DA20 or other external
processor, which is passed through when Film mode is selected or during power off

Analog Audio Output

25-pin male D-connector, balanced for connecting to a Dolby cinema processor
L, C R, Ls, Rs, SW (unassigned channels 7 and 8 pass-through for CP200)
300 mV reference level

To CP Control

25-pin male D-connector for format sensing and control providing a customized interface
for each Dolby cinema processor. This input has a floating common, <+10 V peak between
the DM AS8Plus chassis and common permitted.

To DA Control

25-pin female D-connector for format sensing and control providing a customized interface
for each Dolby cinema processor. This input has a floating common, <+10 V peak between
the DM AS8Plus chassis and common permitted.
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RS-232 Serial Port

9-pin female D-connector for interfacing with software-based automation systems by way
of ASCII command strings

10BASE-T Ethernet Port

Ethernet port for interfacing with Dolby Digital Cinema systems and ASCII command
strings

Digital Media Automation
9-pin female D-connector, ground-switching relay contact closure for each front-panel
button control
Relay contacts provided for CP200 subwoofer control (closure upon any digital format

selection). This input has a floating common, <+10 V peak between the DM A8Plus chassis
and common permitted.

Distortion

<0.005 percent, 4xAES input-to-analog output

Dynamic Range

Digital clip to CCIR/ARM weighted noise
Typically greater than 105 dB

Dimensions and Weight

44 x 483 x 342 mm (1.75 = 19 x 13.5 inches)
Net: 4.5 kg (10 1b)

Environmental Conditions

Operating: 0°C to 40°C (32°F to 104°F)
Nonoperating (storage): 0°C to 85°C (32°F to 185°F)
Humidity: 20 to 80 percent relative, noncondensing

Regulatory Notices

North America: This unit complies with the limits for a Class A digital device, pursuant to
Part 15 of the FCC rules, and Industry Canada ICES-003 specifications. It is UL Listed for
both US and Canada.

Europe: This unit complies with the requirements of Low Voltage Directive 73/23/EEC and
EMC Directive 89/336/EEC and carries the CE marking accordingly.

Warranty

One-year limited, parts and labor
Specifications subject to change without notice
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4.2 Rear-Panel Connector Descriptions and Types
Table 4-1  Rear-Panel Connector Descriptions and Types
Panel Label Description Type
Digital Media Theatre automation control input (momentary DB-9
Automation contact), CP200 subwoofer control
RS-232 In ASCII command string automation control DB-9
10BASE-T Ethernet connector for ASCII command string RJ45
control, setup software, Dolby Digital Cinema
network
To DA Control DAZ20 cinema processor sense control DB-25
To CP Control Cinema processor automation DB-25
Analog Audio In Eight-channel balanced floating analog input for | DB-25
external processor, such as a Dolby DA20
Audio Out to CP Eight-channel balanced floating analog output: | DB-25
L,C R,Ls,Rs, Sw, 7,8
Optical S/PDIF optical, Dolby Digital, PCM, Dolby E Toslink
4xAES In 4 x AES/EBU input (eight-channel PCM audio) DB-25
1xAES In Dolby Digital, PCM, Dolby E 2 x
BNC
100-240 VAC, AC power inlet module with filter IEC
50-60 Hz, 15 W
4.2.1 Digital Media Automation Connector
Table 4-2  Digital Media Connector Pinout
Pin . e
NI Function Specification
1 Digital 1 mode Pulse to pin 5 (push button, relay
contacts, etc.) 100 ms min.
2 Film mode Pulse to pin 5 (push button, relay
contacts, etc.)
3 Digital 2 mode Pulse to pin 5 (push button, relay
contacts, etc.) 100 ms minimum
4 Digital 3 mode Pulse to pin 5 (push button, relay
contacts, etc.) 100 ms minimum
5 Digital media automation common Common for pins 1, 2, 3,4, 8
6 CP200 digital control Return for pin 7
7 CP200 digital control N/O contact closes (latch) to pin 6 in
Digital 1-4 modes
8 Digital 4 mode Pulse to pin 5 (push button, relay
contacts, etc.) 100 ms minimum
9 +5 VDC with respect to pin 5 100 mA maximum current, floating
(current limited) rail
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4.2.2 Analog Audio In/Out Connectors

Caution: The DMAS8Plus has balanced floating analog inputs and outputs. To achieve a
full reference level signal, use both positive (Pos) and negative (Neg) pins for
each channel.

Table 4-3  Analog Audio In/Out Connector Pinout

Analog Audio In

Analog Audio Out

(From DA20) Signal Name (To CP) Signal Name
Pin Number Pin Number

1 Left Neg input 1 Left Neg output

2 Right Surround Pos 2 Right Surround Pos
input output

3 Right Surround Neg 3 Right Surround Neg
input output

4 Left Surround Neg 4 Left Surround Neg
input output

5 Right Extra Neg input 5 Right Extra Neg output

6 Right Neg input 6 Right Neg output

7 Left Extra Neg input 7 Left Extra Neg output

8 Center Neg input 8 Center Neg output

9 Chassis ground 9 Chassis ground

10 Chassis ground 10 Chassis ground

11 Chassis ground 11 Chassis ground

12 Subwoofer Neg input 12 Subwoofer Neg output

13 Chassis ground 13 Chassis ground

14 Left Pos input 14 Left Pos output

15 Left Surround Pos 15 Left Surround Pos
input output

16 Right Extra Pos input 16 Right Extra Pos output

17 Right Pos input 17 Right Pos output

18 Left Extra Pos input 18 Left Extra Pos output

19 Chassis ground 19 Chassis ground

20 Center Pos input 20 Center Pos output

21 Tied to output 21 Tied to input

22 NC 22 NC

23 NC 23 NC

24 Subwoofer Pos input 24 Subwoofer Pos output

band-limited to 300 Hz
in Digital Media mode
25 Tied to output 25 Tied to input
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42.3 4xXAES In Connector

Table 4-4 4XAES In Connector Pinout

Dl\?u-rznsbzlrn Default Signal Name
1 AES Common
2 CH1/2 Neg
3 CH3/4 Pos
4 AES Common
5 CH5/6 Neg
6 CH7/8 Pos
7 AES Common
8 No connection
9 AES Common
10 No connection
11 No connection
12 AES Common
13 No connection
14 CH1/2 Pos
15 AES Common
16 CH3/4 Neg
17 CH5/6 Pos
18 AES Common
19 CH7/8 Neg
20 AES Common
21 No connection
22 No connection
23 AES Common
24 No connection
25 No connection
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42.4 Remote RS-232 Serial Port

Table 4-5 Serial Port Pinout

Pin Number Connection

No connection

Data Out

Data In

Connected to pin 6

Chassis Ground

Connected to pin 4

Connected to pin 8

Connected to pin 7

O | O | | G| | WO N]| ~

No connection

4.2.5 Automation Connections—CP55 with Cat. No. 321 Interface
Table 4-6 CP55 with Cat. No. 321 Automation Interface Card Installed

CP55 with CP55 with

Cat. No. 222 SR/A Module
and Cat. No. 321
(TB2 Fanning Strip)

Cat. No. 222 Module
and Cat. No. 321
(TB2 Fanning Strip)

CP55 GND CP55 GND

59 (mute) S9 (mute)

S8 (main/remote fader) S8 (main/remote fader)

S0 (mono) S0 (mono)

S1 (SR) S1 (A-type without Surround)
52 (A-type with Surround) 52 (A-type with Surround)

S3 S3

54 (magnetic)

54 (magnetic)

S5 S5
56 (nonsync) 56 (nonsync)
S7 (Dolby Digital) S7 (aux)
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4.2.6 Cinema Processor Automation Pin Assignments
Configuration settings provide default selections for cinema processor automation pin
assignments for both film mode and the four digital modes. For example, when selecting a
CP65 cinema processor, the default configuration for film mode is 7 and the default
configuration for digital mode is 5. This corresponds to film mode enabling the CP65
Nonsync format and a digital mode enabling the CP65 Format 10.
Table 4-7  S0-S7 CP Automation Digital Mode Defaults (digital 1-4 defaults shaded)
Pin DMAS8PIlus CP650 CP500 CP65 CP55 CP200 CP45 with
Number | To CP/DA Automation Automation Automation | Automation Cat. No.
Control with Cat. 545A
No. 222 Automation
SR/A Board (J12)
Module
1 (S0) (01) Mono (01) Mono (01) Mono (01) Mono SW Control | (01) Mono
Automation B21 of SK13
select (hold Low for
Digital SW)
2 (S1) (04) Dolby (04) Dolby (04) Dolby (05) Dolby SR | GO (04) Dolby
Automation A-type A-type A-type A-type
select
3 (S2) (05) Dolby SR (05) Dolby SR (05) Dolby SR | (04) Dolby A (05) Dolby SR
Automation A-type
select
4 (S3) (10) Dolby Digital | (10) Dolby Digital | (60) Nonsync / B (05) Dolby
Automation matrix SR
select
5 (S4) (11) Six-channel (11) Six-channel (10) Dolby (22) Magnetic | C (10) Dolby | (10) Dolby
Automation | input input Digital Digital Digital
select
6 (S5) (U1) User 1 (42) Magnetic D (60)
Automation Nonsync
select
7 (S6) (NS) NS1 (60) NS 1 (60) Nonsync/ | (60) Nonsync | Go Monitor | (60) Nonsync
Automation std
select
8 (S7) (U2) User 2 (61) Nonsync 2 (22) Magnetic (10) Dolby Future 11
Automation Digital (A19 of SK27)
select
12 GND GND GND GND GND GND GND
(BS23 Pin 5)
14 Future 8
(A14 of SK15)

Note:

The CP200 default Cinema Processor settings are undefined.
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Table 4-8  S0-S7 CP Automation Film Mode Format Defaults (film defaults shaded)
Pin DMAS8PIlus CP650 CP500 CP65 CP55 CP200 CP45 with
Number | To CP/DA Automation Automation Automation | Automation Cat. No.
Control with Cat. 545A
No. 222 Automation
SR/A Board (J12)
module

1 (S0) (01) Mono (01) Mono (01) Mono (01) Mono SW Control |(01) Mono

Automation B21 of SK13
1
select (hold Low for
Digital SW)

2 (S1) (04) Dolby (04) Dolby (04) Dolby (05) Dolby GO (04) Dolby
Automation A-type A-type A-type SR A-type
select

3 (S2) (05) Dolby SR (05) Dolby SR (05) Dolby SR | (04) Dolby A (05) Dolby
Automation A-type SR
select

4 (S3) (10) Dolby (10) Dolby (60) Nonsync/ B (05) Dolby
Automation | Digital Digital matrix SR
select

5 (S9) (11) Six-channel | (11) Six-channel | (10) Dolby (22) C (10) Dolby | (10) Dolby
Automation |input input Digital Magnetic Digital Digital
select

6 (S5) (U1) User 1 (42) Magnetic D (60)

Automation Nonsync
select

7 (S6) (NS) NS1 (60) NS 1 (60) Nonsync/ | (60) Nonsync | Go Monitor | (60) Nonsync
Automation std
select

8 (S7) (U2) User 2 (61) Nonsync 2 | (22) Magnetic | (10) Dolby Future 11
Automation Digital (A19 of SK27)
select

12 GND GND GND GND GND GND GND

(BS23 Pin 5)
14 Future 8
(A14 of SK15)
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4.2.7 RS-232 ASCII String Commands

Table 4-9  ASCII String Commands

DMAB8PIus ASCII String Parameter or Action
dma8plus.sys.dig_1_global_delay 0-250
dma8plus.sys.dig_2_global_delay 0-250
dma8plus.sys.dig_3_global_delay 0-250
dma8plus.sys.dig_4_global_delay 0-250
dma8plus.sys.dolby_digital 2 channel deco |auto | Ir_discrete | prologic | prologic_2
de_mode
dma8plus.sys.dolby_digital_dialnorm off | on
dma8plus.sys.dolby_e_2_channel_decode_m |auto | Ir_discrete | prologic | prologic_2
ode
dma8plus.sys.dolby_e_dialnorm off | on
dma8plus.sys.dolby_e_program 1-4
dma8plus.sys.input_mode dig 11 dig 21 dig 3 | dig 4 | film
dma8plus.sys.ip_setting [ip.ip.ip.ip nm.nm.nm.nm gw.gw.gw.gw

offlon hostname ]
dma8plus.sys.ntp_server [ hostname | ip_address ]

dma8plus.sys.pcm_2_channel_decode_mode |Ir_discrete | prologic | prologic_2

dma8plus.sys.pcm_mute off | on
dma8plus.sys.pcm_route_1 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_2 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_3 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_4 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_5 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_6 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_7 CILILFEILelLsIRIRelRs
dma8plus.sys.pcm_route_8 CILILFEILelLsIRIRelRs
dma8plus.sys.power_on_input dig 11dig 2 | dig 3 | dig_4 | film | last
dma8plus.sys.silent_switch off | on
dma8plus.sys.subwoofer_filter 50 -100
dma8plus.sys.surround_delay 0-150
help Returns list of commands
status Returns all parameter status
mfg_print_log extract event log

Legacy ASCII Strings Parameter or Action
4xaes_input dig_1 input mode (DMAS legacy string)
aes_input dig_2 input mode (DMAS legacy string)
optical_input dig_4 input mode (DMAS legacy string)
film film input mode (DMAS legacy string)
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42.8 To CP Control Pinouts

Table 4-10 To CP Control (25-pin D output)

21 Description
Number

1 (S0) Automation Select
2 (S1) Automation Select
3 (S2) Automation Select
4 (S3) Automation Select
5 (S4) Automation Select
6 (S5) Automation Select
7 (S6) Automation Select
8 (S7) Automation Select
9 N/C

10 N/C

11 N/C

12 Common

13 N/C

14 N/C

15 N/C

16 N/C

17 N/C

18 N/C

19 N/C

20 N/C

21 N/C

22 N/C

23 N/C

24 N/C

25 N/C
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4.2.9

A

DMAS8PIlus Audio Out to CP Pinouts

Caution: When connecting the DMAS8Plus audio output, be aware that it is balanced. The

balanced design offers a high degree of hum rejection, but be careful when
terminating to a cinema processor with unbalanced inputs.

Although the CP500 and CP650 cinema processors each use an unbalanced
six-channel analog input, this is not a problem, as the unused pins of the
associated 25-pin D-connector are all grounded. For best results, use cable Part
No. 83528, which is properly shielded and wired with matching twisted channel
pairs. We do not recommend using a 25-pin "straight-through" cable.

To properly connect the DMAS8Plus balanced audio output to an unbalanced
audio input, use shielded twisted pair cable (minimum 22 AWG). Connect the
shield at the DMA8Plus end using any of the pins tied to the DMAS8Plus chassis
(9, 10, 11, 13, or 19). Do not connect the shield at the unbalanced end. Each
DMASPIlus audio channel "NEG" output terminates at the unbalanced input
device ground pin. Each DMAS8Plus audio channel "POS" output terminates at
the unbalanced input device positive pin.

Cinema Processor

DMAB8PIus
POS Output = + ) M +~ Signal Input
NEG Output — — +Signal Gnd
i S

When connecting to a CP200, CP45, CP55, or CP65 cinema processor, you must
terminate the negative side of each audio channel of the DMAS8Plus balanced
audio output to the unbalanced cinema processor input ground. Failure to do so
results in a reduced audio output level on that channel (typically -6 dB). The
original audio cables for these processors (“DA20 to CP” audio cables) are
designed for unbalanced audio. As a result, not all grounds are connected to the
negative side of the associated channel when the cable is plugged directly into a
DMAGS8Plus (L, Ls, Rs, and SW are likely to be 6 dB low).

You can use a Cat. No. 757 audio cable adapter dongle with the existing audio
output cable to ensure proper grounding of all channels. For pin configurations,
refer to Table 4-11.

44

Dolby® DMA8Plus Digital Media Adapter Installation and User’s Manual



Rear-Panel Connector Descriptions and Types

Table 4-11  Audio Out to CP Cables (Cat. No. 757 dongle grounds shaded)

Pin DMAS8PIlus CP45 CP55 CP65 CP200 CP500,
No. | Audio Out to Cable Cable Cable Cable CP650
CP 83306.01 83132 83134 83137 Cable
83528
1 Left NEG 1 GND L-
2 Right Surround Rs Rs Rs 2Q Rs+
POS
3 Right Surround 3 Rs-
NEG
4 Left Surround 4 Ls-
NEG
5 Right Extra NEG 5 Re-
6 Right NEG GND GND GND 6 R-
7 Left Extra NEG GND GND GND 7 Le-
8 Center NEG GND GND GND 8 C-
9 Ground GND GND GND 9 GND
10 Ground GND GND GND 10 GND
11 Ground GND GND GND GND
12 Subwoofer NEG SW-
13 Ground GND
14 Left POS L L L 11L L+
15 Left Surround Ls Ls Ls 12P Ls+
POS
16 Right Extra POS 13 Re Re+
17 Right POS R R R 14 R R+
18 Left Extra POS 15 Le Le+
19 Ground 16 GND
20 Center POS C C C 17 C C+
21 Mono Surround 18S Mono_S
(tied directly to
audio input)
22 No connection 19 NC
23 No connection 20 NC
24 Subwoofer POS SW SW SW B1/SK13 SW+
25 Spare (tied Spare
directly to audio
input)
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4.3 Remote Commands and Control
The DMASPIus is designed for remote communication using serial or Ethernet
connections.

4.3.1 Serial

ASCII character strings sent to the rear-panel serial port can be used to set DMAS8Plus
parameters and obtain current DMAS8Plus status information. The currently available
remote commands are listed in Table 4-9.

Serial Communication
Connections can be made from the DMAS8Plus rear-panel serial port to a PC serial port or
other RS-232 device. The serial port speed on your PC should be set to 9,600 bps,

8 data bits, no parity, 1 stop bit. After the DMAS8Plus is powered on, the commands can
simply be typed from a program such as HyperTerminal.

4.3.2 Ethernet
ASCII character strings can be sent through telnet to set DMA8Plus parameters and obtain

current DMAS8Plus status information. The currently available remote commands are
listed in Table 4-9.

Ethernet Communication

Default DMAS8PIlus Ethernet Parameters
IP Address: 192.168.1.131

Command strings must be sent to port 61412
Gateway: 192.168.1.129

Subnet Mask (Netmask): 255.255.255.128
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